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Introduction

Computer simulation is a hallmark of the two-semester biocalculus course sequence at
Benedictine University. In order to bring students who are starting at calculus I level
to be able to engage in research in mathematical or computational biology within a
single academic year, the two courses integrate the mathematics, biology, and com-
puter simulation throughout the year. Computer simulation is particularly important
for learning how to process data, how to qualitatively analyze the dynamics the bi-
ological models, and how to perform some basic programming needed to implement
such models. In the first semester, the students are introduced to the implementa-
tion of some simple models. In the second semester, they are introduced to more
complicated more, which require additional mathematical and computational skills.
Additionally in the second semester, the students engage in an expository research
project which requires them to read a paper about a biological mathematical model
and then implement the model using computational software. In this paper, we focus
on the implementation of two models in Excel. The first model is the dimensionless
discrete logistic model [1], which is studied during the first biocalculus course. The
second model is the Nicholson Bailey host-parasitoid model [2], which is introduced
during the second course. The implementation of this second model is a prototype of
what a student may choose to implement in Excel for this expository research project.

Implementing the Discrete Logistic Equations in Excel

We create a spreadsheet for visualizing the dimensionless discrete logistic equation:

xt+1 = rxt(1 − xt).

This model was studied by May [1]; the fascination with this model is that this seem-
ingly simple equation exhibits complicated dynamical behavior. The dynamics are
briefly explored after the model in implemented in Excel. This model is introduced
early (after about three weeks) in the author’s first semester biocalculus course during
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the unit on difference equations and discrete models. This is the first experience that
the students have with Excel in the course. The most important Excel skills intro-
duced in the implementation of this model are the usage of absolute and relative cell
references, the creation of scroll bars, and the creation of charts of several different
series of data.

This spreadsheet uses the parameter r and the initial value x0 as input values. Both
of these are input using scroll bars. The spreadsheet creates two plots. The first plot
is a time series of the plot of sequence generated by the difference equation for the
given values of r and x0. The second plot is called a cobweb diagram which is used
to determine the stability of equilibria of the model and to explore the dynamics of
the model. Using both plots together, students can develop a good understanding of
the dynamical behavior of the model.

1. Open up a blank worksheet in Excel 2007.

2. If the Developer tab is not present, perform the following steps. Click on the
Microsoft Office Logo in the upper left corner of the window. At the bottom of
the bottom of the menu that appears, click on Excel Options . Make sure the
Popular tab is selected. The third item in the main portion of the window will
have a check box for “Show Developer tab in the Ribbon.” Check this check
box and click OK at the bottom of the window.

3. Rename Sheet1 “Home” and Sheet2 “Data”. To do this for Sheet1, double click
on the Sheet1 tab so that “Sheet1” is highlighted. Now type “Home” in the
tab.

4. In cell A1, entitle the worksheet “The Discrete Logistic Equation”.

5. In cell A2, enter the difference equation “x t + 1 = rx (1 − x t)”.

6. The spreadsheet will be designed so that the growth rate, r, and the initial
value, x0 are variable quantities. We create scroll bars for both of them.

(a) Enter “r” in A4 and “x 0” in A5.

(b) We next name the cells that will contain the values for r and x0. Move
the cursor to cell B4. In the Name box in the upper left corner of the
spreadsheet, type, “rate”. Move the cursor to cell B5. In the Name box in
the upper left corner, type “initialvalue”.

(c) We now create the scroll bar for r. Click on the Developer tab. From the
Controls palette, click on Insert. A palette of controls appear. From the
Forms list, select the scroll bar icon, which is the third icon in the second
row of controls. The cursor becomes a cross; drag the cursor from the top
left of cell C4 to the bottom right of cell D4.
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(d) Now right click on the scroll bar and select Format Control from the menu.
Enter the following values:

Minimum Value 0 Incremental Change 1
Maximum Value 500 Cell Link C4

(e) Now in cell B4, enter “=C4/100”.

(f) To create the scroll bar for x0, we cut and paste the scroll bar which we
just created. To do this, right click on the scroll bar, type Ctrl-C and then
Ctrl-V. A new scroll bar has now been created and is highlighted. Use the
cursor to position this scroll bar immediately blow the first one covering
cells C5 and D5. Right click on this new scroll bar and select Format
Control from the menu. Update the following values:

Minimum Value 0 Incremental Change 1
Maximum Value 100 Cell Link C5

(g) In cell B5, enter “=C5/100”.

7. We now create the data table for the sequence generated by the difference
equation with initial condition x0.

(a) In cell A7, enter “t” and in cell B7, enter “x t”.

(b) Enter 0 and 1 in cells A8 and A9, respectively.

(c) Select both cells A8 and A9. Notice a small black square (handle) at the
bottom right of the outline of this selected region. Move the cursor to
this handle and drag the handle straight down to cell A108. The t column
should now be the list of integers from 0 to 100.

(d) In cell B8, enter, “=initialvalue”.

(e) In cell B9, enter, “=rate*B8*(1-B8)”.

(f) With cell B9, highlighted, double click on the handle. The remainder of
the x t column should now be filled. Just to check, the contents of cell
B108 should be “=rate*B107*(1-B107)”.

8. In cell F2, enter “Nontrivial Equilibrium”. In cell I2, enter “=1 - 1/rate”.

9. Enter “min” in cell M2 and “max” in cell M3. Enter the values 0 and 1 in cells
N2 and N3, respectively. Using the technique above, name cell N2 “hmin” and
cell N3 “hmax”.

10. We now create the data table to plot the updating function of the difference
equation in the cobweb diagram.

(a) Go to the Data worksheet by clicking on its tab below the spreadsheet.
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(b) In cell A1, enter “Updating Function”. In cell A2, enter “x t”, and in cell
B2, enter “x t+1=f(x t)”.

(c) In cell D2, enter “increment”. In cell E2, enter “=(hmax-hmin)/1000”
and name cell E2 “increment”. This increment value is difference between
successive input values in the updating function.

(d) In cell A3, enter “=hmin”.

(e) In cell A4, enter “=A3 + increment”. With this cell highlighted, move
the cursor to the handle and drag it straight down to cell A1003. At this
point, the value of cell A1003 should be 1.

(f) In cell B3, enter “=rate*A3*(1-A3)”. With this cell highlighted, move the
cursor to the handle and drag it straight down to cell B1003.

11. The final data table contains the cobweb data. We proceed to create this table.

(a) In cell D3, enter “Cobweb Data”. Enter “x t” and “x t+1” in cells D4 and
E4, respectively.

(b) Enter “=Home!B8” in cell D5 and “=D5” in cell D6.

(c) In cell D7, enter “=rate*D5*(1-D5)”. Highlight cell D7, move the cursor
to the handle of cell D7, and drag the handle straight down to cell D106.

(d) In cell E5, enter “0”.

(e) In cell E6, enter “=D7”. With this cell highlighted, move the cursor to the
handle and drag it straight down to cell E105.

12. We now create the plot of the sequence xt generated by our difference equation
with initial condition x0 and the growth rate parameter r.

(a) Select the Insert tab. From the Charts palette, select the Scatter menu.
By using the roll over help, select the “Scatter with Straight Lines and
Markers” option. A blank chart area will appear. Move the chart and
resize the chart area so that the chart area covers the region with top left
cell D7 and bottom right cell K24.

(b) With the chart area selected (highlighted), right click and then choose

Select Data from the menu. Click the Add button. The Edit Series menu
appears. Enter the following:

Series name: =“Times Series”
Series X values: =Home!$A$8:$A$108
Series Y values: =Home!$B$8:$B$108

Click OK . Click OK again.
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(c) With the chart still highlighted, click on the Layout tab. From the Axis
Labels menu, first select Primary Horizontal Axis Title and then Title
Below Axis. A text box appears below the horizontal axis. Highlight and
delete the contents of this text box and replace with “t”.

(d) From the Axis Labels menu, select Primary Vertical Axis Title and then
Rotated Title. A text box appears to the left of the vertical axis. Highlight
and delete the contents of this text box and replace with “x t”.

(e) From the Axes palette, select Gridlines, Primary Vertical Gridlines, and
then Major Gridlines.

13. We now create the cobweb diagram.

(a) Select the Insert tab. From the Charts palette, select the Scatter menu.
By using the roll over help, select the “Scatter with Straight Lines and
Markers” option. A blank chart area will appear. Move the chart and
resize the chart area so that the chart area covers the region with top left
cell M6 and bottom right cell U24.

(b) With the chart area selected (highlighted), right click and then choose

Select Data from the menu. Click the Add button. The Edit Series menu
appears. Enter the following:

Series name: =“Cobweb Diagram”
Series X values: =Data!$D$5:$D$105
Series Y values: =Data!$E$5:$E$105

Click OK . Click OK again.

(c) With the chart area selected (highlighted), right click and then choose

Select Data from the menu. Click the Add button. The Edit Series menu
appears. Enter the following:

Series name: =“Equilibrium”
Series X values: =Home!$I$2
Series Y values: =Home!$I$2

Click OK . Click OK again.

(d) Right click on the plotted equilibrium point on the chart. Select Format
Data Series. Choose Marker Options and select Built-in. Set Type to the
triangle marker and Size to 7. Choose Line Color and select No line. Click
on Close .

(e) With the chart area selected (highlighted), right click and then choose

Select Data from the menu. Click the Add button. The Edit Series menu
appears. Enter the following:
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Series name: =“Updating Function”
Series X values: =Data!$A$5:$A$1005
Series Y values: =Data!$B$5:$B$1005

Click OK . Click OK again.

(f) Right-click on the plot of the updating function. Select Change Series
Chart Type. Select Scatter with Smooth Lines.

(g) With the chart area selected (highlighted), right click and then choose

Select Data from the menu. Click the Add button. The Edit Series menu
appears. Enter the following:

Series name: =“Updating Function”
Series X values: =Data!$A$5:$A$1005
Series Y values: =Data!$B$5:$B$1005

Click OK . Click OK again.

(h) With the chart still highlighted, click on the Layout tab. Select Chart Title
and then Above chart. A text box appears above the chart. Highlight and
delete the contents of this text box and replace with “Cobweb Diagram”.

(i) From the Axis Labels menu, first select Primary Horizontal Axis Title
and then Title Below Axis. A text box appears below the horizontal axis.
Highlight and delete the contents of this text box and replace with “x t”.

(j) From the Axis Labels menu, select Primary Vertical Axis Title and then
Rotated Title. A text box appears to the left of the vertical axis. Highlight
and delete the contents of this text box and replace with “x t+1”.

(k) From the Axes palette, select Gridlines, Primary Vertical Gridlines, and
then Major & Minor Gridlines.

Investigation of The Discrete Logistic Equation

The following exercise enables students to explore the dimensionless discrete logistic
equation using the spreadsheet that was just developed. Students will be able to
observe stable behavior, periodic behavior, period doubling, and chaotic behavior.
For the following, assume that 0 < x0 < 1.

1. Algebraically calculate the equilibria of the difference equation.

2. Find a value of r for which xn approaches the nontrivial (nonzero) equilibrium
as n increases without bound. What is the equilibrium value? Does {xn}
approach the nontrivial equilibrium monotonically or with oscillations? How is
this reflected in the cobweb diagram?
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3. Find a value of r for which {xn} approaches a cycle of period 2. What are the
values in the 2-cycle? How is this reflected in the cobweb diagram? What can
you say about the stability of the nontrivial equilibrium?

4. Through experimentation, estimate the smallest value of r for which {xn} ap-
proaches a cycle of period 2.

5. Find a value of r for which {xn} approaches a cycle of period 4. What are the
values in the 4-cycle? How is this reflected in the cobweb diagram?

6. Through experimentation, estimate the smallest value of r for which {xn} ap-
proaches a cycle of period 4. (You may wish to expand the size of the graphs
at this stage.)

7. Find a value of r for which {xn} is aperiodic. How is this reflected in the cobweb
diagram? Change the value of x0 by 0.01. Comment on the how the time series
plot and the cobweb diagram have changed after changing x0.

Implementation of the Nicholson Bailey Model

The Nicholson Bailey model [2] is given by

Nt+1 = bNte
−aPt = f(Nt, Pt)

Pt+1 = cNt(1 − e−aPt) = g(Nt, Pt),

where Nt is the size of the host population in the tth generation, Pt is the size of

the parasitoid population in the tth generation, b and c are growth parameters, and
a is parameter that characterizes the fraction of the host population that escapes
parasitism. (Specifically, the factor e−aPt is the fraction of the Nt that escapes par-
asitism.) We denote the initial populations of the host by N0 and the parasitoid by P0.

This spreadsheet creates time-series and phase plane plots to study the dynamics of
the model geometrically. The spreadsheet also provides the analytical determination
of stability of equilibria through the calculation of the Jacobian matrix, eigenvalues
and eigenvectors, and a test for stability. As in the previous spreadsheet, the values of
the parameters a, b, and c and the initial values N0 and P0 are controlled by scroll bars.

1. Label the current worksheet, Sheet1, “Home”.

2. Create Sliders for the parameters a, b, and c, and the initial population values
N0 and P0 in the model.
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Row/
Column A C D E-F

3 Initial Number N0 Slider from 0 to 20, incremental

of Hosts change 1, linked to D3

4 Initial Number P0 Slider from 0 to 20, incremental
of Parasitoids change 1, linked to D4

5 Host Escape Rate a =E5/100 Slider from 0 to 100, incremental

change 1, linked to E5

6 Host Growth b =E6/10 Slider from 0 to 100, incremental

Parameter change 1, linked to E6

7 Parasitoid Growth c =E7/10 Slider from 0 to 100, incremental
Parameter change 1, linked to E7

Note: Cells D3 and D4 will be filled with slider values.

3. Click on Sheet2, and change its name to “Data”.

4. Label cell A4“T”, cell B4 “N”, cell C4 “P”.

5. Fill the A column from A5 to A205 with the integers 0, 1,2, . . ., 200.

6. Enter “=Home!$D$3” in B5 and “=Home!D4” in C5.

7. In B6, enter “=Home!$D$6*B5*EXP(-Home!$D$5*C5)” and in C6,
enter “=Home!$D$7*B5*(1 - EXP(-Home!$D$5*C5))”

8. Copy the formulas in B6 and C6 down their respective columns through row
205. At this point, the times series data has been generated.

9. In the Home worksheet, create a phase plane diagram of P versus N . Label the
axes and give the graph a title. Use an XY scatter plot without connecting the
points.

10. By copying the phase plane diagram, create a new phase plane diagram in which
the points are connected by smoothed lines.

11. In the Home worksheet, create a chart containing plots of P versus T and N

versus T . Make the horizontal axis range from 0 to 50 and the vertical axis
range from 0 to 100. Again, use XY scatter plots and connect the points with
smoothed lines.

12. The point (0, 0) is the trivial equilibrium of this system, and (N̂ , P̂ ) =
(

P̂ b

c(b−1)
,

ln(b)
a

)

is the nontrivial equilibrium of the system. In cell L5, enter the expression
“=LN($D$6)/$D$5” for P̂ , and in cell L4, enter the expression Enter the ex-
pression “=$L$5*$D$6/($D$7*($D$6 -1))” for N̂ . Label these cells by entering
appropriate titles in cells H4 and H5, respectively.
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13. We need to compute the Jacobian of this system evaluated at the nontrivial
equilibrium (N̂, P̂ )

J(N̂, P̂ ) =

[

∂F

∂N

∂F

∂P
∂G

∂N

∂G

∂P

]

and its eigenvalues to determine whether the nontrivial equilibrium is locally
stable or unstable.

We enter the Jacobian into Excel as follows:

Cell Expression Cell Expression
B12 1 B13 =-$D$5*$L$4
C12 =$D$7:*(1-1/$D$6) C13 =$D$5*$L$4*$D$7/$D$6

In cell A11, enter the title for the Jacobian matrix, “Jacobian Matrix at Non-
trivial Equilibrium=J”.

14. If the magnitudes of both eigenvalues of the Jacobian matrix are less than one,
the equilibrium is locally stable. If at least one eigenvalue has magnitude greater
than 1, the equilibrium is unstable. The spreadsheet will determine stability
by directly calculating the eigenvalues and by using the Jury Conditions below.
We begin this process by placing the determinant of the Jacobian in cell F12
and the trace of the Jacobian in cell F13. Name cell F12 “Det” and cell F13
“Trace”. Enter the label “Det(J)” in cell E12 and “Trace(J)” in cell E13.

15. Excel does not compute in terms of complex numbers, but we need to be able
to work with complex eigenvalues. To do this, we perform the following calcu-
lations that return the real and imaginary parts of the eigenvalues separately.
Enter the following in K21:

=SQRT((Trace^2-4*Det+ABS(Trace^2-4*Det))/2)

Enter the following in K22:

=SQRT((-(Trace^2-4*Det)+ABS(Trace^2-4*Det))/2)

Name K21 “alpha” and K22 “beta”.

16. Enter “Lambda1” and “”Lambda2” into H12 and H13, respectively. Make sure
the Data Analysis Add-In has been installed so that the following commands
will work. Enter the value of the eigenvalue “Lambda1” in cell I12:
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=COMPLEX(ROUND((Trace+alpha)/2,4),ROUND(beta/2,4))

Enter the value of eigenvalue “Lambda2” in cell I13:

=COMPLEX(ROUND((Trace-alpha)/2,4),ROUND(-beta/2,4))

Enter the magnitude of these eigenvalues in cells J12 and J13. The formula for
the norm of “Lamdba1” is given by:

=IMABS(COMPLEX((Trace+alpha)/2,beta/2))

17. For a system of two nonlinear difference equations, there are necessary and
sufficient conditions that indicate when both eigenvalues of the Jacobian are
less than one in magnitude. Let J = J(N̂, P̂ ). The Jury conditions state
that both of the eigenvalues of J have magnitude less than one if and only if
2 > 1 + Det(J) > |Trace(J)|.

Implement this test in Excel by entering “1 + Det(J)” in N6, “|Trace(J)|”, in
N7, “=1 + Det” in O6, and “=ABS(Trace)” in O7.

Enter “Jury Test” in N9, “Stability” in N10, “=IF(AND(2 > $O$6,$O$6 >

$O$7),“SATISFIED”,“FAILED”)” in O9, and “=IF($O$9=“SATISFIED”,
“LOCALLY STABLE”,“UNSTABLE”)” in O10. What you observe here should
be consistent with the observed magnitudes of the eigenvalues of the Jacobian.
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